Excel for Data Management and Manipulation

WRITTEN BY:
Ivan Hemmans
Allan Mackenzie

PRESENTER:
Allan Mackenzie: @EfficientAllan

April 16, 2019
Table of Contents

1. Forward ............................................................................................................................ 4
2. Introduction ..................................................................................................................... 4
3. Getting Comfortable ........................................................................................................ 4
   3.1 Excel’s Interface ........................................................................................................... 4
   3.2 Entering Text ................................................................................................................ 5
   3.3 Entering Cell Addresses .............................................................................................. 6
      3.3.1 Relative References ............................................................................................. 6
      3.3.2 Absolute References ............................................................................................ 6
      3.3.3 Mixed References ................................................................................................ 6
   3.4 Insert Function ............................................................................................................. 7
4. Understanding the Database (List, Table) Rules .............................................................. 7
   4.1 Database, List, Table Definitions .................................................................................. 7
   4.2 Streamlining The “Database” Process ......................................................................... 8
5. Number Crunching ........................................................................................................... 8
   5.1 PivotTables .................................................................................................................... 8
      5.1.1 Structure Your Data for PivotTables .................................................................... 9
      5.1.2 Anatomy of the Pivot Table ............................................................................... 9
      5.1.3 Ask a Question of Your Data ............................................................................ 11
   5.2 Managing Large Lists of Data ..................................................................................... 12
      5.2.1 Features of an Excel Table ............................................................................... 12
      5.2.2 Converting Back to a Regular Range ............................................................... 12
   5.3 Amortization ................................................................................................................ 13
   5.4 The Magic of Sub Totaling, at Each Change ............................................................... 13
      5.4.1 Embedding Excel Data in a Word Document ..................................................... 15
6. Text Manipulation .......................................................................................................... 16
   6.1 Separating Data into Units or Fields .......................................................................... 16
      6.1.1 Text to Columns ............................................................................................... 16
      6.1.2 Trim(), Right(), Left(), Mid(), and Len(), Find() .............................................. 18
      6.1.3 Combining Find() with the Others .................................................................... 20
   6.2 What’s the Catch? The Secrets You are Never Told .................................................... 21
      6.2.1 Cleaning Up Data .............................................................................................. 21
6.3 Putting Data Together Again ........................................................................................................ 21
  6.3.1 The Concatenation Operator ................................................................................................. 21
  6.3.2 Data Entry Keyboard and Discontiguous Selection .......................................................... 23
  6.3.3 The Long-Forgotten Data Entry Form .................................................................................. 24
6.4 Data Validation .......................................................................................................................... 24
  6.4.1 Data Validation Tutorial ....................................................................................................... 25
  6.4.2 Creating Drop Down Lists in Cells .................................................................................... 25
7. A Few General Excel Tips ........................................................................................................... 25
  7.1 Adjust screen zoom with CTRL + Scroll .................................................................................. 25
  7.2 Ctrl + Shift + Arrow ................................................................................................................ 25
  7.3 Automatically fill a series with a “double-click” ....................................................................... 25
1. Forward

We are thrilled to be asked to speak again on what has to be in our Top 5 Topics for lawyers, in the category of “did you even KNOW you could already do this.” This document is not a word-for-word outline of the presentation. Rather, it is a reference to the “how we did it” question. Please reach out us for copies of the particular spreadsheet that intrigued you if you wish.

2. Introduction

If you are like most legal professionals, you’re either underutilizing Excel or not using it at all. In this paper, we start with the basics and work our way up from there. You’ll learn powerful ways that Excel can improve your work product and make your life easier, and how to produce flawless accountings such as amortization schedules.

And if that doesn’t surprise you, then perhaps this will. Many professionals do not realize that Microsoft Excel is not merely a number cruncher, it is also a text manipulator, and data massager! The product of any of the work you do in Excel is easily ported to Word, PowerPoint, even the web – complete with animations. Did you know Excel can “exist” inside Word document or PowerPoint presentation? Did you know there are easy data-entry tools to enter all manner of bits of information? You can even sort and filter on-the-spot without any, well, sort of query programming language knowledge.

So let us help you get comfortable with Excel’s basic tools, and then launch you into the world of not only numbers, but text lists!

3. Getting Comfortable

Microsoft Excel is a powerful application and it can potentially save you hours of work under the right circumstances. However, many people look it and are intimidated by its grid of cells. The simple truth is that most people choose Excel to: 1) Manage large lists of data, 2) Run calculations with formulas, or 3) Summarize data with graphs or other reports.

3.1 Excel’s Interface

Regardless of the version of Excel your firm uses, there are some common elements you can rely upon. Let’s begin with some basic terminology. People use Microsoft Word to create documents, PowerPoint to create presentations, and Excel generate workbooks. In the Figure 1 below, this new file is called “Book1” and it contains a single worksheet named “Sheet1.” By default, each workbook contains three worksheets.
The majority of the Excel Window is dominated by a grid of “cells.” These cells are the intersection of vertical columns, which are topped with letters of the alphabet, and horizontal rows that begin with a number label. Each cell is named according to the letter column and number row that intersect. In Figure 1, the selected cell is A1.

Above column “A” is the name box, which displays the name of the selected cell on the worksheet. As you can see, A1 is the selected cell. The selected cell indicates where text will appear should you begin to type. To the right of the name box are three buttons. They are, in order from left to right are: Cancel, Enter, and Insert Function. In earlier versions of Excel, the Cancel and Enter buttons only appear while the cursor is focused within a cell as you type. Clicking Cancel discards any typed text and reverts to what was in a cell before typing began. Clicking Enter saves any typed text into the selected cell. We’ll talk more about the Insert Function button in just a few moments.

To the right of the Insert Function button is a large white rectangle. This rectangle is called the formula bar and displays to contents of any selected cell in the workbook.

Excel 2004 and earlier had toolbars that appeared above the Name box. Excel 2007 and later feature Microsoft’s Ribbon interface.

### 3.2 Entering Text

For the purposes of this paper, we will make the assumption that you have some basic understanding of using Excel to enter text. And, while there are many ways to get text or numbers into a cell, let us abbreviate by describing, in its simplest form, how to enter text.

Position the mouse pointer on a cell, then click to select it. Afterward, do one of the following:

- Type to overwrite what is in the cell
- Click in the formula bar to place the cursor within the cell
- Press **F2** to place the insertion point in the cell, at the end of any existing text.

Once text is in the cell, press Enter or click the checkmark to the left of the formula bar.

**Note:** You can enter a line break, which works like a hard return, within a cell by pressing **ALT+Enter**.

### 3.3 Entering Cell Addresses

A cell is named for where a column letter and row number intersect. The first cell in the workbook is A1, where column “A” intersects with row number “1.” While you can type cell addresses — or range of addresses — by hand, it is far easier to click or click and drag. Excel expects cell addresses when the equal sign is the first character in a cell, in other words, as part of a formula. After that, click another cell, whether it is in the same workbook or in a different one and Excel writes the name of the cell for you, making note of the workbook name and worksheet, if necessary.

Entering a cell address — or range of addresses — as part of a formula is called referencing a cell. Excel can reference cell addresses in three ways: relative, absolute, and mixed. By default, Excel uses relative cell references.

#### 3.3.1 Relative References

Frequent users of Excel formulas know that the program will automatically adjust relative cell references when a formula is copied from one cell to another. For example:

If the following formula =A6 + A7 is copied from column “A” to column “C”, it becomes =C6 + C7.

#### 3.3.2 Absolute References

An absolute cell reference utilizes the dollar sign ($) for each part of a cell address, in front of both the column and row. Use an absolute reference to “lock onto” a particular cell from within a formula so that when the formula is copied, that address reference doesn’t change. For example:

If =$A$6 + A7 is copied from column “A” to column “C”, it becomes =$A$6 + C7.

#### 3.3.3 Mixed References

A mixed reference is one where one component of the cell address, either the column or row, uses a dollar sign and the other does not. For example, $A1$ is a reference where the column reference will not change as the formula is copied while the row reference can change. Cell reference A$51$ is a mixed reference where the column letter may change and the row number may not as a formula is copied.
3.4 Insert Function

Excel contains a vast array of functions you can use to perform various calculations. Use **Insert Function** to become familiar with the functions available in Excel and to become familiar with what each of the functions does.

Select an empty cell, then click Insert Function to summon a dialog box that allows you to find formulas you seek. You can search for a function by keyword or by category. Alternatively, in Excel 2007 or later, you can click the **Formulas** tab and browse a collection of formulas by category in the **Function Library**, see Figure 2, below.

As you will see when using Insert Function or the Function Library, Excel will begin to write formulas for you. Each formula begins with `=`, the equals sign. Typing `=` into a cell as the first character tells Excel that you are about to enter a formula and expect it to perform some calculation in the workbook.

![Figure 2 Formulas Tab](image)

4. Understanding the Database (List, Table) Rules

Before we go any further, there is a basic assumption of organization that should be addressed. Much of what is FUN in Microsoft Excel assumes that Excel understands which part of the Excel spreadsheet you wish to manipulate or analyze. It must understand what is contained within your “List” or “Database.”

4.1 Database, List, Table Definitions.

While there are more technical options and opinions, the crude definition of a “database” in Microsoft Excel is explained something like this:

“A contiguous area in a spreadsheet bounded by blank rows or columns, though it may contain blank cells – preferably with the top row containing field names”
Another rule of thumb, while not a requirement for all purposes, is that the column headings or field names should contain single words, or put another way, “no spaces”. “First Name” is not ok. “FirstName” “First-Name” or “First_Name” are. This is usually only necessary when the excel spreadsheet is used as a data source for other programs, such as a Microsoft Word mail merge.

4.2 Streamlining The “Database” Process

In earlier versions of Microsoft Excel, following the Database rules were your own responsibility. If you made the mistake of having a blank row or a blank column in Excel, anything below or to the right of these boundaries could easily be left out. As you will learn below, adding fancy tools such as Filters could be a manual process.

Later versions of Excel helped eliminate errors by giving you a menu choice to help not only define the area of your database, but also format it and add the Filtering and other tools in one easy step. You will learn more about this in Features of an Excel Table below. For the Official Microsoft descriptions, see the article “Overview of Excel Tables” at this Link: [https://support.office.com/en-us/article/Overview-of-Excel-tables-7ab0bb7d-3a9e-4b56-a3c9-6c94334e492c](https://support.office.com/en-us/article/Overview-of-Excel-tables-7ab0bb7d-3a9e-4b56-a3c9-6c94334e492c)

5. Number Crunching

We all know that Excel is a powerhouse when it comes to crunching numbers. It has a good collection of built-in Math & Trig, Date & Time, and Financial formulas that can do kinds of fancy calculations. In addition to these functions, there is a hugely helpful tool that summarizes what all of those numbers mean; it’s called a PivotTable.

5.1 PivotTables

A PivotTable is a reporting tool you can use to analyze a large amount of data. With a PivotTable, you can create totals, subtotals, and more. In addition, you can compare the totals of one column to another.
You can “pivot” the data in this report to display it vertically or horizontally.

5.1.1 Structure Your Data for PivotTables

Excel is arranged in rows and columns. Arranging your data in rows and columns — or columns and rows — will help you when it’s time to run reports.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>Case</td>
<td>Case #</td>
<td>Role</td>
<td>Lead</td>
<td>Practice Group</td>
<td>Fee App</td>
<td>Period</td>
<td>% Paralegal Time to Total Time</td>
</tr>
<tr>
<td>2</td>
<td>2004</td>
<td>Corporate Client B, Ltd.</td>
<td>14-03023-ROR</td>
<td>Comm-Lead</td>
<td>Electronic Discovery &amp; Doc Retention</td>
<td>1-May-04</td>
<td>30-Apr-04</td>
<td>5%</td>
</tr>
<tr>
<td>3</td>
<td>2004</td>
<td>Corporate Client A, Inc.</td>
<td>06-11623-HNY</td>
<td>Comm-Lead</td>
<td>Class Action Defense</td>
<td>1-Nov-04</td>
<td>30-Nov-04</td>
<td>5%</td>
</tr>
<tr>
<td>4</td>
<td>2004</td>
<td>Corporate Client B, Ltd.</td>
<td>06-11623-MHE</td>
<td>Comm-Lead</td>
<td>Class Action Defense</td>
<td>1-Oct-04</td>
<td>31-Oct-04</td>
<td>8%</td>
</tr>
<tr>
<td>5</td>
<td>2004</td>
<td>Corporate Client B, Ltd.</td>
<td>14-03023-ROR</td>
<td>Comm-Lead</td>
<td>Electronic Discovery &amp; Doc Retention</td>
<td>30-Dec-04</td>
<td>31-Dec-04</td>
<td>8%</td>
</tr>
<tr>
<td>6</td>
<td>2005</td>
<td>Corporate Client A, Inc.</td>
<td>06-11623-HNY</td>
<td>Comm-Lead</td>
<td>Class Action Defense</td>
<td>10-Apr-04</td>
<td>30-Apr-04</td>
<td>9%</td>
</tr>
<tr>
<td>7</td>
<td>2005</td>
<td>Corporate Client B, Ltd.</td>
<td>05-29466-BMV</td>
<td>Comm-Lead</td>
<td>Global Enforcement &amp; Criminal Def</td>
<td>1-Feb-06</td>
<td>26-Feb-06</td>
<td>10%</td>
</tr>
<tr>
<td>9</td>
<td>2004</td>
<td>Corporate Client B, Ltd.</td>
<td>14-03023-ROR</td>
<td>Comm-Lead</td>
<td>Electronic Discovery &amp; Doc Retention</td>
<td>1-May-04</td>
<td>31-May-04</td>
<td>12%</td>
</tr>
<tr>
<td>10</td>
<td>2004</td>
<td>Corporate Client A, Inc.</td>
<td>06-11623-HNY</td>
<td>Comm-Lead</td>
<td>Class Action Defense</td>
<td>1-Dec-04</td>
<td>31-Dec-04</td>
<td>12%</td>
</tr>
<tr>
<td>11</td>
<td>2004</td>
<td>Corporate Client B, Ltd.</td>
<td>05-29466-BMV</td>
<td>Comm-Lead</td>
<td>Global Enforcement &amp; Criminal Def</td>
<td>1-Feb-06</td>
<td>26-Feb-06</td>
<td>10%</td>
</tr>
<tr>
<td>12</td>
<td>2004</td>
<td>Corporate Client B, Ltd.</td>
<td>14-03023-ROR</td>
<td>Comm-Lead</td>
<td>Electronic Discovery &amp; Doc Retention</td>
<td>1-Feb-04</td>
<td>26-Feb-04</td>
<td>10%</td>
</tr>
</tbody>
</table>

Figure 4 PivotTable Data Structure

Each row should be dedicated to a single item in your list. For example, if your spreadsheet contains an employee list, then each row could be dedicated to a single employee. Each column should be dedicated to a single attribute of the row item. Column “A” could be dedicated to the employee’s “Name” and column “B” could be dedicated to the employee’s “Title.” So, row 7’s “A” column might refer to “Anna” and the “B” column might say “CEO,” while row 8’s “A” column might refer to “Kyle” and the “B” column might say “Associate.”

In the Figure above, Column “A” is dedicated to “Year,” Column “B” is “Case,” Column “C” is “Case#,” etc.

If you need to track additional attributes, just add another column of data to your spreadsheet.

5.1.2 Anatomy of the Pivot Table
A PivotTable consists of 4 areas, the Report Filter, Column Labels, Row Labels, and Values.

- **Row Labels**: When you drag a field into this area, Excel creates a list of unique values found and displays each as its own row.
- **Column Labels**: When you drag a field into this area, Excel creates a list of unique values found and displays each as its own column.
- **Values**: When you drag a field into this area, Excel sums or counts the items according to the groupings within the Row or Column Labels.
- **Report Filter**: When you drag a field into this area, Excel creates a top-level filter to control which data is displayed in the PivotTable.
- **PivotTable Field List**: The field list displays a list of all the column headers from the worksheet to which the PivotTable is linked.
- **PivotTable Tools**: A ribbon appears with tabs for controlling Options and Design.

You can use the PivotTable Tools to adjust the options and display settings for the PivotTable.
5.1.3 Ask a Question of Your Data

The great thing about PivotTables is that they can be used to “ask a question of your data.” The question can be simple or complex, but each PivotTable in your workbook answers just a single question. For example, in Figure 4 we may wish to know the answer to this question, “What is the average “Percentage of Paralegal Time to Total Time” by “Practice Group?” With a PivotTable, you can get an answer to this question in a matter of seconds, regardless of whether your source data is comprised of one hundred rows or ten thousand.

To answer this particular question, we must first insert the PivotTable into the workbook, click **Insert > PivotTable**, then click **OK**. In the PivotTable, on the new worksheet that appears, drag the **Practice Group** field to the **Row Labels** area, then the **Percentage of Paralegal Time to Total Time** field to the **Values** area.

The new PivotTable displays a “Sum” of the field we placed in the Values area, as you can see in Figure 6. To change to an Average, click the small disclosure triangle to the right of the field name in the **Values** area. Then click **Value Field Settings > Summarize value field by > Average**, then click **OK**.

As you can see in Figure 7, below, the PivotTable shows the answer to our question. Now, if you’d like to format how the average appears, you can return to the **Value Field Settings** options and click **Number Format** to adjust how you’d like it to be displayed.

You now have enough information to begin using PivotTables in your workbooks.
5.2 Managing Large Lists of Data

If you are working with a large list of data, or even if your list isn’t so large, you can group related items together as a Table in Excel. Once grouped, Excel enables a small collection of features designed to make managing your list easier.

It’s also worth noting that if you create a PivotTable or graph based on an Excel Table that graph and PivotTable become “aware” of new rows as they are added.

5.2.1 Features of an Excel Table

Every Excel Table has several prominent features, which can be used to manage large lists of data. Figure 8 shows these features in a small sample table.

- **AutoFilter**: You can use AutoFilter to filter or sort your list.
- **Ledger lines**: Actually, these are Table Styles that help make table data easier to see.
- **Insert Row**: When you press the **Tab** key in the last row of the Table or data in the blank row after the last Table row, the list grows to accommodate it.
- **Total Row**: When this row is enabled, you can select from several predefined functions to calculate results for a given column.
- **Resize Handle**: Drag the handle horizontally or vertically to include new columns or rows in the list range.
- **Table Tools Ribbon**: The Table Tools ribbon includes a number of formatting and options to get the most from the table, including Total Row, which can tabulate column totals automatically based on visible column data.

In addition to the prominent Table features, formatting options and formulas are automatically copied to new Table rows as they are added. And it’s also worth noting that totals in the Total row at the bottom of a Table work in combination with the AutoFilter and total only visible rows, like subtotals.

![Figure 8 Example Excel Table](image)

5.2.2 Converting Back to a Regular Range
Excel Tables degrade gracefully in older version of Excel. However, if you wish to remove one from your workbook, select a cell within the Table. Click the Design tab, and then Convert to Range in the Tools group.

5.3 Amortization

There are times when Microsoft just says it best!

Link: How to create an Excel Loan Amortization Schedule (Document Archived) - https://support.microsoft.com/en-us/kb/816643

But even better, what if Microsoft did it for you. This is just one of those cases where the work has been handed to you on a Silver Platter. From the File Ribbon in Excel, Choose New, and type LOAN into the search box and click the magnifying glass. Voila! A menagerie of mortgage munching machines!

![New](image_url)

**Figure 9 - Microsoft Excel Online Amortization Templates**

5.4 The Magic of Sub Totaling, at Each Change

If you know your “sums”, then you know you need them often. Using the Sum() function or simply using a formula such as =A1+A2+A3 may work well at the bottom of a large list. What if you need subtotals? Inserting additional Sum functions can be very painful and tedious but it is totally unnecessary if you use Excel’s subtotals menu. The only prerequisite is that the data must be sorted by the items you wish subtotaled. In the example below the data is sorted by...
name. This was accomplished by clicking anywhere within the list, and from the Data ribbon clicking the Sort icon.

![Figure 10 - Sort Dialog](image1.png)

![Figure 11 - Example Sorted Excel List](image2.png)

By clicking on the DATA ribbon and then clicking the icon SUBTOTAL on the outline group will be given the following options:
In this case since we wish to subtotal for each person the first dialogue has the choice name chosen, the function is some, and the columns to be summed our Widgets and Gizmos. Click okay and you get exactly what you need. Note that you can click the + or - to expand or contract the outline. It is then possible to select and copy or paste what is subtotaled and outlined into other forums such as Word or Outlook.

![Subtotal Dialog](image)

![Subtotals](image)

### 5.4.1 Embedding Excel Data in a Word Document

When you copy Excel data and paste it into Microsoft Word, you have 3 or 4 basic ways in which the data can be pasted, depending on what you’ve copied. When copying cells containing data, your choices are essentially:

- Paste as a Word table
- Paste as an embedded object
- Paste as a linked object, or
- Paste as a picture.

When copying a chart or graph, the options are essentially, all but the first option listed above are available.
Be advised that pasting as an embedded object includes an entire copy of the Excel workbook, including all worksheets and formulas, in the Word document. If you share the Word document with others, you may be sharing more information that you expect.

Pasting as a linked object will include an image in the Word document that links back to the source Excel file. If a person opens the Word document, but doesn’t have the linked Excel document nearby, then the pasted element may not be visible.

In general, pasting as a picture is the safest option, however the ability to double-click and edit in Excel is not available with this choice.

6. Text Manipulation

Whether you are a litigation sort of person or transactional in practice, “lists” of things come into play all the time. And while you may have found the sort feature in Word tables, there is OH so much more that can be accomplished in Microsoft Excel prior to your final Document format is ready to be printed. Excel can pull things apart, put them back together again, add tidbits of information in-between others, re-arrange data and make quick sense of “too much.”

One of the mantras you should keep in mind is – “if I am typing it over again, I’m probably doing it wrong.

6.1 Separating Data into Units or Fields

6.1.1 Text to Columns

If you’ve ever been in a conundrum where data has been provided to you in a sort of congealed mass like the below, it is very easy to separate the bits of information into their respective categories, or fields.

![Figure 14 - Comma Separated Values](image-url)
By clicking on the column heading “A” to select the entire column, and then going to the Data Ribbon and choosing Text to Columns, the following Wizard appears. If the data has separators such as commas, the term is “Delimited” – choose Next. Tell step 2 what the delimiter is.

**Figure 15 - Convert Text to Columns Step 1**

**Figure 16 - Convert Text to Columns Step 2**

In Step 3 you may choose, column by column, how the data should be formatted. You may also skip this step and worry about formatting later by clicking Finish.

**Figure 17- Convert Text To Columns Step 3**

The result? A real database!
6.1.2 Trim() Right(), Left(), Mid(), and Len(), Find()

Suppose for a moment that you are not able to do the Text to Column trick. What then? You can both Clean the data as well as EXTRACT the data. Let’s focus on the latter.

6.1.2.1 Extracting Data

In this case the term extracting means simply pulling specific bits of data out of column A and into column B. For example, if you needed to extract the zip code from column A then the function Right() is just the ticket.

6.1.2.2 Right()

RIGHT returns the last character or characters in a text string, based on the number of characters you specify.

Using the fill down handle to extend the formula to the rest of the cells you can extract the ZIP Code in a snap.
6.1.2.3 Left()

As you have probably guessed, the function left does pretty much the same thing but from the opposite side.

*LEFT returns the first character or characters in a text string, based on the number of characters you specify.*

![Figure 21 - The Left() Function](image)

If you think the results are just a bit erratic, you are correct! Not all names have the same number of letters. That’s where the Find function comes into play, which is just a few more items down the page.

![Figure 22 - The Left() Function Results](image)

6.1.2.4 Mid()

*MID returns a specific number of characters from a text string, starting at the position you specify, based on the number of characters you specify.*

6.1.2.5 Len()

*LEN returns the number of characters in a text string.*

6.1.2.6 Find()

*FIND locates one text string within a second text string, and return the number of the starting position of the first text string from the first character of the second text string.*

In this example, we find out which position the first comma holds.
6.1.3 Combining Find() with the Others

So let’s take the Find concept and put it together with the left concept.

Left() as we saw above will pull a certain number of characters from the left of a cell, and is written something like this:

=LEFT(A2,5)

We also know that find will provide the position of a specific character.

=Find(“,",A2)

So if we plug the Find() Function in where the number 5 is in the Left() function, then subtract “1”, the first name can be extracted thusly:
Just imagine being able fill that formula down one thousand or more rows. That is POWER!

6.2 What’s the Catch? The Secrets You are Never Told

There’s just one tiny problem with all of these examples. The cells in column B are full of formulas. If you need that data AS data somewhere else, what do you do? The answer is simple!

Copy that column and either in another column or even in the SAME column (yes that’s right, the SAME column) and use the “down arrow” under the Paste button on the HOME ribbon and choose VALUES. The result is formula-free.

6.2.1 Cleaning Up Data

6.2.1.1 Trim()

Removes all spaces from text except for single spaces between words. Use TRIM on text that you have received from another application that may have irregular spacing.

6.3 Putting Data Together Again

After data is residing in its separate “units” (fields), it is simple and FAST to re-arrange those units into an arrangement appropriate to your task. Simply select a Column by clicking the Column heading (A, B, C), right click and Cut – go somewhere else and paste.

Or, click the Column heading (A, B, C) then use the mouse to touch the selection boarder. A compass rose will appear. Click and Drag to move the ENTIRE column. (Take THAT Microsoft Word!)

If that’s just a bit much to visualize – here’s a video link: https://youtu.be/lFfwB2DzUMY

6.3.1 The Concatenation Operator
Sometimes you realize that maybe the information you’ve finally separated into “parts” is just a little TOO granular. No problem here. You know there is always an “and” in every situation, and here it is:

“&”

which is also known as the concatenation operator. Like “+” or “-“it tells Excel what to do with bits of information – combining them and/or augmenting them.

In the Text to Columns Example, the Data was separated into Fields like this:

![Excel Screen](image.png)

*Figure 27 - Pre-Concatenation Data*

But let’s say for a moment that a “Last, First” list was needed. Enter The Concatenator! This little symbol simply means *combine*. So if you entered the following:

=B2&A2

the result would be:

ParkerDarren

Therefore, =B2&”,”&A2 yields what is needed

Parker, Daren
Fill the formula down and bingo, you’ve got your data concatenated.

Just remember to Copy/Paste Special/Values to get rid of the formula when you are done.

6.3.2 Data Entry Keyboard and Discontiguous Selection

You can preselect the cells in which you wish to place data. Click on the first cell. Then while using the CTRL key, click on additional cells. Then, using the TAB key you can move from cell to cell to enter data.
### 6.3.3 The Long-Forgotten Data Entry Form

As long as your data is arranged in a true database form, you can use a long forgotten tool called the data entry form to enter data in a vertical format as opposed to a horizontal. The data form tool once had a hallowed place on the Microsoft Excel toolbars system. But since the advent of ribbons, the tool has been hidden deep inside customizations. By right clicking on your quick access toolbar and choosing customize the quick access toolbar then choosing all commands from the drop-down alphabetically you will find data entry form and you can add it to the toolbar.

Once the data form is available in the quick access toolbar (highlighted in yellow below) as long as the active cell selected is within the database, a data entry form is automatically created based upon the fields in the list or database. Using this miraculous tool makes data entry a breeze and automatically appends new records to the bottom line of the list.

---

### 6.4 Data Validation

Another seldom used tool is similar to cell formatting called data validation. Using this menu choice, you can predefine limits or formatting on specific cells as well is create drop-down lists!
During our demonstration we will be showing valuable applications of Data Validation. For the official stance, please see the following links.

6.4.1 Data Validation Tutorial


6.4.2 Creating Drop Down Lists in Cells

https://support.office.com/en-us/article/Create-or-remove-a-drop-down-list-5a598f31-68f9-4db7-b65e-58bb342132f7

7. A Few General Excel Tips

Every Excel veteran knows that this program are tons of little time-saving tips and tricks. We’d like to share 3 quick ones with you that can potentially save you hours and hours of time.

7.1 Adjust screen zoom with CTRL + Scroll

If you have a mouse with a scroll wheel, you can adjust the zoom level by pressing and holding the CTRL key, then scrolling the wheel.

7.2 Ctrl + Shift + Arrow

You can use this key combination to highlight a range of cells along the same row or within the same column. The Ctrl key tells Excel to continue across a range of non-empty cells once you press the Arrow key to indicate direction. The Shift key is what triggers the highlighting. You can navigate the spreadsheet quickly by omitting Shift from this shortcut.

7.3 Automatically fill a series with a “double-click”

When you select a cell, you can automatically copy its contents down the column as far as the adjacent column of data goes. Double-click the AutoFill handle.